
By Evghenii Sestacov

Broadcasting Services Division

ITU Radiocommunication Bureau

ITU HQ, Geneva 

Online Workshop

September – October 2020

Search for new FM frequencies
in the GE84 Optimization process



- Tools to be used

- Frequency band and assigned frequencies

- Technical basis for the GE84 Opt process

- Process diagrams

- Preparation of requirement (examples)

- Compatibility calculations

- Analysis of the results

- Exercise

Overview

2



Tools to be used

TerRaQ

TerRaNotices WISFAT
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https://www.google.com/url?q=http://www.itu.int/pub/R-SP-LN.IT/en&sa=U&ei=HIu9Ud3AJuic0AW8hIGYDA&ved=0CA4QFjAD&client=internal-uds-cse&usg=AFQjCNHwTQMAnIRPgtyg-z5NtwJTbqJi7A


Frequency band and assigned frequencies

✓ Frequency band:    87.6 - 107.9 MHz

✓ Assigned frequencies: 87.6; 87.7;…; 107.8; 107.9 MHz  (100 kHz step)

✓ Special case (“flexible frequency (flexible channel)”): 

“flexible channel” – means that during compatibility calculations,
the software will scan all frequencies in the frequency band 
mentioned above and show electromagnetic situation on each co- and
adjacent frequencies. 
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Technical basis for GE84 Optimization process

➢Technical criteria used for compatibility calculations – GE84 Agreement 
(uniform 100 kHz frequency step, protection ratios, propagation model etc.)

➢Assignments recorded in the GE84 Plan and as well as assignments published in Part A 
of Special Sections GE84 are taken into account

➢Assignments to other primary services in adjacent bands are not taken into account

➢ It is proposed that participating administrations agree:
▪ To stop submissions of new modifications to the GE84 Plan until the end of the 

coordination meetings;
▪ To submit their requirements every other Friday to brbcd@itu.int for next 

iteration. If an administration does not submit its requirements, the requirements 
used for the previous iteration will be taken; 

▪ General maximum acceptable Nuisance Field Strength (NFS) value is 54 dB(V/m). 
This value can be reviewed by involved administrations during 
bilateral/multilateral negotiations
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GE84 Optimization process and BR assistance

Agreed assignments
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A new iteration every 
other week

Submission of the 
requirements by 

participating 
administrations every other 

Friday to BRBCD@itu.int

Compatibility calculations 
run by the BR based on the 

submitted requirements 
and assignments recorded 

in GE84 Plan as well as 
published in Part A

Publication of the 
requirements and  

compatibility calculation 
results on the ITU website

Assistance to participants 
along the process in the 

analysis and proposals to 
reduce potential 

interference
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GE84 Optimization process 
and activity of administrations

7

Validate 
the notice file

Y

Submit 
the file to eTools

(GE84 Optimization)

N

Is a suitable 
freq. found?

N

Y

N

Create/Modify 
requirement (notice) 

Y

Y

N

Get calculation results 
and analyze them

No errors?

Assign the frequency to 
the requirement and 

remove FLEX

Keep the requirement
In the notice file

Are
all requirements 

treated?

Coordination 
completed?

N

Add coordination 
information to relevant 

requirement(s)

Submit the file to 
brbcd@int.int
for iteration

Wait for results
of iteration

Are  
results

OK?

Check 
the results of iteration

Flowchart 
of actions required from 

an Administration 

Y

Send the file 
to Adm(s) concerned

for coordination

Submit notice file to 
WISFAT at the end of 

iteration process 

Y



Preparation of requirement (example 1)
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Prepare a requirement (notice) on flexible channel assigned to a sound broadcasting station based 
on the information below, using TerRaNotices tool and selecting the Administration of Namibia 
(NMB) as notifying administration.

Transmitting antenna site name ARIAMSVLEI

Coordinates of the transmitting antenna site 19°50’00’E 28°08’00‘’S

Height of the antenna above ground level 66 m 

Effective antenna height (m) at 36 different azimuths 

in 10 degrees interval

To be calculated using TerRaNotices

facility

Polarization Vertical

Effective radiated power 37 dBW

Antenna directivity ND

Transmission system 4

Necessary bandwidth* 300 kHz (see Rec. ITU-R SM. 1138)

Assigned frequency** 87.7 MHz

Station identification FLEX

Administration’s Unique identification code Example

* For assigned frequency 87.6 MHz or 107.9 MHz the indicated necessary bandwidth shall be 200 kHz;
** For requirement on flexible channel the assigned frequency shall be 87.7 MHz.



Preparation of requirement (cont.)
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Validation and Submission of notice file(s) to eBCD

✓ Validation of notice(s):
▪ Initial - by TerRaNotices:  File -> Validate and save file 

▪ Deep – by Online validation tool at https://www.itu.int/ITU-
R/terrestrial/OnlineValidation/Login.aspx

▪ The notice file shall not contain errors.

✓ Submission of the notices to eBCD:
o Go to eBCD web-portal - eTools: https://www.itu.int/ITU-R/eBCDMVC/

o Select:

▪ GE84 calculation type 

▪ GE84 Optimization option

o Click on New calculation

o Change configuration information if needed. More information and description of 
results can be found in etools Documentations -> GE84 Compatibility analyses

o Browse and Upload the notice file together with the notice files of neighboring 
countries to eBCD web-portal

o Label your job and click on Submit
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Submission of the created notice file (example)
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Submission of the created notice file (example)
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Submission of the created notice file (example)
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Submission of the created notice file (example)
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Getting Compatibility Analysis results

✓ Click on Back to calculation history

✓ Wait for results (either email message received or by clicking time-to-
time on Refresh until job status becomes Success)

✓ Click on the job Id number to see the results

✓ Select desired modes for considering interference and Set Acceptable 
NFS 

✓ Click on Evaluate Statistics

✓ Click on administration’s name and on number below Submitted or 
Assignable 

✓ Select the desired requirement for analysis

✓ Analyze the compatibility calculation results 
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Getting Compatibility Analysis results
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✓ File -> Open compatibility results file G_VRG_Road Town_flex.mdb
✓ View -> Channel distribution statistics
✓ Check appropriate boxes and set a default margin
✓ Select Administration and click Refresh
✓ Select item of interest and click on the blue number
✓ List of requirements will appear
✓ Select the requirement of interest and click on it

Getting Compatibility Analysis results



18

Analysis of compatibility calculation results:
Interferers
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Analysis of compatibility calculation results:
Affected

ERP of the requirement 
under consideration
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Summary of the compatibility calculation results
on a frequency-by-frequency basis in the range 87.6 – 107.9 MHz 

(fragment of Excel file)

Frequency 
(MHz)

Max NFS Generated 
(dB(µV/m))

Max NFS Received 
(dB(µV/m))

… … …
103.8 136.95 146.95
103.9 110.95 120.95
104 96.95 106.95

104.1 83.95 93.95
104.2 37.41 52.23
104.3 49.41 64.23
104.4 57.11 79.16
104.5 69.11 91.16
104.6 57.11 79.16
104.7 39.11 58.69
104.8 42.21 56.39
104.9 52.42 67.53
105 46.89 67.61

105.1 58.89 79.61
… … …
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Outcome of the compatibility analysis

Conclusions: 

1) Calculated NFSs on frequency 104.2 MHz in both directions 
(generated and received) do not exceed the acceptable NFS value, 
therefore it can be assigned to this site.

2) To fix this, it is necessary to modify the initial notice containing  
87.7 MHz and FLEX by changing assigned frequency to 104.2 MHz 
and removing FLEX.

3) Also frequencies 107.8 MHz or 107.9 MHz can be assigned to this 
site bearing in mind that adjacent frequencies in the range ±300 kHz 
from the selected frequency are considered as non-assignable.
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Outcome of the compatibility analysis
General recommendation

If no assignable frequency has been found it is advisable to apply for a selected 
frequency:

➢ Detailed calculations involving digital terrain map (for example based on 
Rec. ITU-R P.1812).

➢ Coordination with neighbors concerned. In case of successful coordination 
please don’t forget to insert this information in the COORD section of the 
notice.

➢ Change of technical characteristics of the requirement in question. Please 
keep in mind that the calculated NFSs might be changed by modifying:

―Polarization, location;

―Antenna height, Effective Radiated Power (for generated NFS only).

➢ Removal of excessive requirements.

➢ Combination of above.



Outcome of the compatibility analysis
Another chance: Best practices approach

If no assignable frequency has been found, using this approach it is also possible to assign frequencies with 400 kHz 
difference between co-sited transmitters as shown on example rounded in green below:

Source: Swiss Federal Office of Communications (OFCOM)  https://www.bakom.admin.ch/bakom/en/homepage/frequencies-and-antennas/broadcasting.html
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Compatibility calculations
Specific case: FLEX vs FLEX requirements
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Preparation of requirement (example 2)
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Prepare a requirement (notice) on flexible channel assigned to a sound broadcasting station based 
on the information below, using TerRaNotices tool and selecting the Administration of South Africa 
(AFS) as notifying administration.

Transmitting antenna site name AUGRABIES

Coordinates of the transmitting antenna site 20°24’00’E 28°34’00‘’S

Height of the antenna above ground level 220 m 

Effective antenna height (m) at 36 different azimuths 

in 10 degrees interval

To be calculated using TerRaNotices

facility

Polarization Vertical

Effective radiated power 37 dBW

Antenna directivity ND

Transmission system 4

Necessary bandwidth* 300 kHz (see Rec. ITU-R SM. 1138)

Assigned frequency** 87.7 MHz

Station identification FLEX

Administration’s Unique identification code Example

* For assigned frequency 87.6 MHz or 107.9 MHz the indicated necessary bandwidth shall be 200 kHz;
** For requirement on flexible channel the assigned frequency shall be 87.7 MHz.



Analysis of compatibility calculation results:
Interferers
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Analysis of compatibility calculation results:
Affected



FLEX vs FLEX requirements
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➢ Co-channel compatibility calculations only (i.e. worst 
case scenario)

➢ To estimate a possibility of frequency re-use (sharing)

In the example above, calculated NFSs in both directions exceed 
acceptable NFS value, thus between these sites frequency re-use

is not possible 



Exercise (optional)

➢ Create a notice file containing 1 requirement on flexible channel per 
site (up to 3 sites) of your administration with no more than 100 km 
distance between them.

➢ Submit the created file to eTools. 

➢ Analyze the results obtained.

➢ Assign relevant frequency for each site.

➢ Resubmit the obtained notice file to eTools for re-checking.

➢ Re-check the results.
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Some useful links

➢https://www.itu.int/en/ITU-R/terrestrial/broadcast/africa/Pages/default.aspx

➢https://www.itu.int/en/ITU-R/terrestrial/broadcast/Pages/FMTV.aspx

➢https://www.itu.int/en/ITU-
R/terrestrial/tpr/Pages/FMTVNotices.aspx#FMTVNotices

➢https://www.itu.int/ITU-R/eBCDMVC/
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Thank you for your attention!

Questions?

brbcd@itu.int

mailto:evghenii.sestacov@itu.int

